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1 Introduction 

This guide describes how to do the following: 

• For Local Cases:

• upgrade LiveNote SR cases to West Case Notebook version 2.0 or later or West LiveNote version 2.0 or 
later cases

• upgrade West Case Notebook version 1.0 or later or West LiveNote version 1.0 or later cases to West Case 
Notebook 2.0 or later or West LiveNote 2.0 or later cases

• For LiveNote Repositories:

• upgrade LiveNote Repository version 8 to West LiveNote Repository version 2.0 or later

• upgrade LiveNote Repository version 9 or 10 to West LiveNote Repository 2.0 or later

• upgrade West LiveNote Repository version 1.0 to West LiveNote Repository 2.0 or later

• access updated cases with West Case Notebook or West LiveNote from West LiveNote Repository 2.0 or 
later

• For RealLegal Binder Projects:

• open RealLegal Binder projects in West Case Notebook 2.0 or later or West LiveNote 2.0 or later 

• import RealLegal Binder projects into West LiveNote Administration version 2.0 or later
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2 Upgrading Local Cases

Upgrading LiveNote SR Cases
To upgrade LiveNote SR Cases to West Case Notebook 2.0 or later or West LiveNote 2.0 or later cases, complete 
these steps:

1. Access West Case Notebook or West LiveNote. The Open Case dialog box is displayed (Figure 2-1).

Figure 2-1. Open Case dialog box

2. Click Add. The Open dialog box is displayed (Figure 2-2).

Figure 2-2. Open dialog box

3. Select LiveNote SR Case (.lnt) from the File of type drop down list.

4. Select the *.lnt file for the case you want to open. 

Notes

• If you use Windows XP, LiveNote SR cases are located in C:\ProgramFiles\LiveNote\LiveNote\Cases, as 
shown in (Figure 2-2). 

• If you use Windows Vista, LiveNote SR cases are located in C:\Users\Public\Public Documents\Cases.

5. Click Open. The message This case was created with an earlier version of LiveNote. It must be upgraded before 
it can be used. Do you want to continue? is displayed. 
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6. Click Yes. The Save As dialog box is displayed (Figure 2-3). By default, West Case Notebook or West 
LiveNote cases are saved as LiveNote Project (*.lnp) files in C:\Documents and Settings\All Users\Shared 
Documents\ West LiveNote\Cases.

Figure 2-3. Save As dialog box

7. Click Save.The case is listed in the Open Case dialog box. 

8. To open the case, select the case and click OK.

Upgrading West Case Notebook or West LiveNote Cases 
When you install version 2.0 or later of West Case Notebook or West LiveNote, the previous versions are 
automatically uninstalled. When you use version 2.0 or later to open cases that you created with previous 
versions of West Case Notebook or West LiveNote, version 2.0 or later upgrades the cases as it opens them.
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3 Upgrading LiveNote Repositories

Upgrading LiveNote Repository Version 8
Note Version 8 refers to any LiveNote Repository version 8, e.g., version 8.2 or 8.3. 

To upgrade LiveNote Repository version 8 to West LiveNote Repository 2.0 or later, complete these steps:

1. Access West LiveNote Administration on the computer with LiveNote Administration version 8. The 
Administrator Login for [repository name] dialog box is displayed.

2. Type your username and password in the Username and Password text boxes and click Login. The West 
LiveNote Administration window is displayed.

3. From the Repository menu, choose Import Repository (version 8). The Select the Repository (Secure Case 
Folder) to Import dialog box is displayed.

4. Select the sc.lnr file and click Open. All users and groups that are not already in the repository are imported. 
If case information is stored in the sc.lnr file, the Select Cases to Import dialog box is displayed (Figure 3-1).

Figure 3-1. Select Cases to Import dialog box

5. By default, all cases are selected. To exclude a case from the upgrade, clear its check box. 

6. Click OK. If the cases contain annotations, the Select an Owner for the Annotations dialog box is displayed.

7. Select an owner and click OK. The Select Case Import Destination dialog box is displayed.

8. Click Browse. The Browse for Folder dialog box is displayed. 

9. Select a destination directory for the upgraded cases and click OK. The Select Case Import Destination 
dialog box is redisplayed.

10. Click OK. Imported cases, users and groups are listed on the Cases, Users, and Groups tabs respectively. 

Upgrading LiveNote Repository Version 9 or 10
To upgrade LiveNote Repository version 9 or 10 to West LiveNote Repository 2.0 or later, complete these steps:

1. Access West LiveNote Administration on a computer with LiveNote Administration 9 or 10. The 
Administrator Login for [repository name] dialog box is displayed.

2. Type your username and password in the Username and Password text boxes and click Login. The West 
LiveNote Administration window is displayed.
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3. From the Repository menu, choose Manage. The Manage Repositories dialog box is displayed (Figure 3-2).

Figure 3-2. Manage Repositories dialog box

4. Click Upgrade. The Upgrade Repositories dialog box is displayed (Figure 3-3).

Figure 3-3. Upgrade Repositories dialog box

5. Select a repository and click Upgrade. The Repository Upgrade Options dialog box is displayed.

6. Type the administrator’s username and password for the old repository in the Username and Password text 
boxes. 

7. Click the Browse button. The Browse for Folder dialog box is displayed. 

8. Select the destination directory for the upgraded cases and click OK. The Repository Upgrade Options 
dialog box is redisplayed (Figure 3-4).

Figure 3-4. Repository Upgrade Options dialog box
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9. By default, Quietly skip any open or offline cases is selected. If desired, select Prompt me when an open or 
offline case is encountered during the upgrade or Quietly upgrade open and offline case. (Select this last 
option only if cases are inappropriately flagged as open.)

10. Click OK. The Repository Upgrade Results dialog box is displayed (Figure 3-5).

Figure 3-5. Repository Upgrade Results dialog box

11. Click OK. The Upgrade Repositories dialog box is displayed.

12. To upgrade another repository, select it and then click Upgrade. Otherwise, click Close. The Manage 
Repositories dialog box is displayed. 

13. Click Close.

Note See Appendix B for information on linking from a transcript annotation sent from LiveNote version 8.3 or 
later to CaseMap to West Case Notebook version 2.6 or West LiveNote version 2.6.

Upgrading West LiveNote Repository Version 1.0 or Later 
West LiveNote Repository version 1.0 or later is upgraded automatically when you install West LiveNote 
Administration 2.0 or later. When you install West LiveNote Administration 2.0 or later, the previous versions are 
automatically uninstalled. 

All users of a secure case must use the same version of West Case Notebook or West LiveNote. For example, if a 
secure case is upgraded to West LiveNote 2.0 or later, all users working on the case must use West LiveNote 2.0 
or later.

If you are working in a West LiveNote 2.0 or later case, then revert to using West LiveNote version 1.0, you must 
manually rebuild the search index for the case. To rebuild the search index, choose Advanced, Rebuild Search 
Index from the Tools menu (Figure 3-6). 

Figure 3-6. Tools menu
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Accessing Updated Cases in West Case Notebook or West LiveNote
To access updated cases in West Case Notebook or West LiveNote, complete these steps:

1. Access West Case Notebook or West LiveNote. Or in an open case, choose Open Case from the File menu. 
The Open Case dialog box is displayed (Figure 3-7).

Figure 3-7. Open Case dialog box

2. Click Repositories in the Open Case dialog box. The Repositories dialog box is displayed (Figure 3-8).

Figure 3-8. Repositories dialog box

3. If your repository is not listed in the Repositories dialog box, click Add to display the Add Repository Server 
dialog box (Figure 3-9). 

Figure 3-9. Add Repository Server dialog box

4. Type the name of the server in the Server text box or click Locate to automatically search for the repository.

5. Click Ok. The Repositories dialog box is redisplayed.

6. Select the repository that you want to log on to and click Logon. The Logon to [Repository Name] dialog box 
is displayed (Figure 3-10). 

Figure 3-10. Logon to [Repository Name] dialog box 
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7. Type your username and the password in the Username and Password text boxes. 

8. Select the Remember my logon settings check box if you want West LiveNoteCase Notebook to remember 
your username and password.

9. Click OK. The Repositories dialog box is redisplayed (Figure 3-11).

Figure 3-11. Repositories dialog box

10. Click Close. The Open Case dialog box is redisplayed with a list of the cases to which you are assigned 
(Figure 3-12).

Figure 3-12. Open Case dialog box

Upgrading to West Case Notebook TS or West LiveNote TS Repositories
Use the same steps outlined above to upgrade to West Case Notebook TS or West LiveNote TS repositories.
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4 Importing RealLegal Binder Cases

Opening a RealLegal Binder Case in West Case Notebook or West LiveNote
You can open a RealLegal Binder case, version 5 or later, in West Case Notebook 2.0 or later or West LiveNote 
2.0 or later. To open a RealLegal Binder case, complete these steps:

1. Choose Open Case from the File menu to display the Open Case dialog box (Figure 4-1).

Figure 4-1. Open Case dialog box

2. Click Add. The Open dialog box is displayed (Figure 4-2).

Figure 4-2. Open dialog box

3. Choose RealLegal Binder Case (.pxl) from the Files of Type drop-down list.

4. Select the .pxl file for the case you want to import and click Open.

5. The message This case was created with RealLegal Binder. It must be imported before it can be used. Do you 
want to continue? is displayed. Click Yes. The Save As dialog box is displayed.
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6. Type a name for the file in the File name text box and click Save. The case is listed in the Open Case dialog 
box (Figure 4-3).

Figure 4-3. Open Case dialog box

7. Select the case and click OK.

Note The RealLegal Binder case opens as a local case with no assigned users. For further information on the 
conversion of RealLegal Binder cases to West Case Notebook version 1.5 or West LiveNote version 1.5 
cases, see Appendix A: Converting RealLegal Binder Cases to West Case Notebook or West LiveNote Cases.

Importing a RealLegal Binder Case into West LiveNote Administration
You can import a RealLegal Binder case, version 5 or later, into West LiveNote Administration 2.0 or later. To 
import a RealLegal Binder case, complete these steps:

1. Access West LiveNote Administration.

2. From the Case menu, choose Import. The Select the Case to Import dialog box is displayed (Figure 4-4).

Figure 4-4. Select the Case to Import dialog box
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3. Click Browse to display the Browse for a Local Case dialog box (Figure 4-5).

Figure 4-5. Browse for a Local Case dialog box

4. Go to the folder where your RealLegal Binder cases are located and select the .plx file for the case you want 
to import. By default, RealLegal Binder cases are located in C:\Program Files\RealLegal Binder\Projects.

5. Click Open. The Select the Case to Import dialog box is redisplayed (Figure 4-6).

Figure 4-6. Select the Case to Import dialog box
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6. Click Next. The Select the Destination Location dialog box is displayed (Figure 4-7).

Figure 4-7. Select the Destination Location dialog box

7. Type a case name in the Case Name text box.

8. Type a different location in the Case Path text box, if desired.

9. Type a different case file name in the Case File text box, if desired.

10. Under Case Details, select the Managed check box if you want to manually add users and groups to this 
case.

11. Type a client-matter number in the Client-Matter text box, if desired.

12. Type a comment in the Case Comments text box, if desired

13. Click Next to display the Import Completed dialog box.

14. Click Finish. Your case is added to the list of secure cases in the repository on the Cases tab (Figure 4-8).

Figure 4-8. West LiveNote Administration Cases tab
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Appendix A: Converting RealLegal Binder Cases 

When you open a RealLegal Binder case in West Case Notebook version 1.5 or West LiveNote version 1.5, the 
properties for the case may or may not be converted. The following chart describes how the RealLegal Binder case 
properties are converted.

ITEMS THAT ARE CONVERTED ITEMS THAT ARE NOT CONVERTED

Transcripts Transcripts

• transcript text 

• transcript properties: Type, Status, Last, 
First, Volume, Date, Title, Taking Attorney, 
For, Comment

• transcript properties: Time, Plaintiff, 
Defendant

• links to documents from transcripts

• signature for signed transcripts 
(version 7.0 and later)

• video sync information

Documents Documents

• document contents • document properties: Title

• document properties: Type, Author, 
Recipient, Bates Range, Date, OCR 
information

• exhibit check box data; exhibit number; 
exhibit prefix

Annotations Annotations

• all annotations • chronology date

• issues, including name and color • active issue properties

• attachment URLs are preserved

• comments converted to notes

• annotations authors only converted when 
imported into a secure case

Search groups Search groups

• search groups converted to data groups

• search group name converted to data group 
title

• preprogrammed search groups that come 
with RealLegal Binder

• transcripts and documents from the search 
group converted to Data Group

• saved reports
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Appendix B: Send to CaseMap from 
LiveNote–Link Conversion Utility

If you sent transcript annotations from LiveNote version 8.3 or later to CaseMap, you must use the Link 
Conversion Utility to view the full annotated transcript in West Case Notebook version 2.6 or West LiveNote 
version 2.6. It is recommended that you use the utility after you upgrade your LiveNote version 8.3 or later cases 
to West Case Notebook version 2.6 or West LiveNote version 2.6 cases. 

Notes

• You can view annotations in West Case Notebook version 2.6 or West LiveNote version 2.6 that you sent 
from LiveNote version 8.3 or later.

• The transcript in West Case Notebook or West LiveNote must have the same name as the transcript in 
LiveNote from which you sent the annotation. 

• If the page and line numbers in the transc ript change during the upgrade process, you may need to scroll up 
or down a few lines in the transcript to view the annotation.

To download the utility, go to west.thomson.com/software/case-notebook/cm-livenote-utility/default.aspx and 
click Proceed with Download.

To use the Link Conversion Utility, complete these steps:

1. Double-click the Link Conversion Utility icon ( ) on your desktop. The Open File–Security Warning dialog 
box is displayed (Figure 1).

Figure 1. Open File–Security Warning dialog box
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2. Click Run. A dialog box is displayed (Figure 2).

Figure 2. CaseMap LiveNote Link Conversion Utility

3. Click Add Case. The Select dialog box is displayed (Figure 3).

Figure 3. Select One or More CaseMap Cases to Process dialog box

4. Select the CaseMap cases containing the LiveNote transcript annotation links you want to convert and view 
in West Case Notebook or West LiveNote.

5. Click Open. Your selected case is listed on the Selected Cases tab (Figure 4). 

Figure 4. CaseMap LiveNote Link Conversion Utility dialog box–Selected Cases tab
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6. Click Process. A message indicating that the case was updated is displayed on the Results tab (Figure 5).

Figure 5. CaseMap LiveNote Link Conversion Utility dialog box–Results tab

7. Click Close. 

8. Access CaseMap and open the case with the transcript annotations you sent from LiveNote.

9. Click the paper clip icon ( ) next to the annotation you want to view in West Case Notebook or West 
LiveNote, then click the name of the transcript. If the case with the transcript annotation is not open in West 
Case Notebook or West LiveNote, the Open Case dialog box is displayed. Select the case and click OK.The 
transcript opens and the annotation is displayed in the right pane. 
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